<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surf-Lock2</td>
<td>15</td>
</tr>
<tr>
<td>App-Control</td>
<td>15</td>
</tr>
<tr>
<td>Pointer</td>
<td>15</td>
</tr>
<tr>
<td>Licensing</td>
<td>15</td>
</tr>
<tr>
<td>Licensing During Installation</td>
<td>16</td>
</tr>
<tr>
<td>Licensing After Installation</td>
<td>17</td>
</tr>
<tr>
<td>30-Day Trials</td>
<td>17</td>
</tr>
<tr>
<td>Setting Up Vision in the Classroom</td>
<td>19</td>
</tr>
<tr>
<td>Create a Classroom</td>
<td>19</td>
</tr>
<tr>
<td>Rename a Classroom</td>
<td>21</td>
</tr>
<tr>
<td>Delete a Classroom</td>
<td>22</td>
</tr>
<tr>
<td>Install Vision on Students with Classroom Installer</td>
<td>22</td>
</tr>
<tr>
<td>Configure Vision for Wireless Networks</td>
<td>24</td>
</tr>
<tr>
<td>Connect to a Classroom and Monitor Student Computers</td>
<td>25</td>
</tr>
<tr>
<td>Add or Remove a Student Computer from a Classroom</td>
<td>26</td>
</tr>
<tr>
<td>Exit Vision</td>
<td>28</td>
</tr>
<tr>
<td>Vision Windows and Toolbars</td>
<td>29</td>
</tr>
<tr>
<td>About the Floating Toolbar</td>
<td>31</td>
</tr>
<tr>
<td>Thumbnails View</td>
<td>32</td>
</tr>
<tr>
<td>Details View</td>
<td>33</td>
</tr>
<tr>
<td>Perspective View</td>
<td>34</td>
</tr>
<tr>
<td>Change How You View Your Classroom Computers</td>
<td>34</td>
</tr>
<tr>
<td>Save or Remove a Customized View</td>
<td>34</td>
</tr>
<tr>
<td>Change the Image Size of a Student Computer</td>
<td>35</td>
</tr>
<tr>
<td>Zoom In On a Student Computer</td>
<td>35</td>
</tr>
<tr>
<td>Working with Student Computers</td>
<td>36</td>
</tr>
<tr>
<td>Associate Each Classroom Computer with a Student</td>
<td>36</td>
</tr>
<tr>
<td>Select One or More Student Computers</td>
<td>37</td>
</tr>
<tr>
<td>Create a Group of Student Computers</td>
<td>38</td>
</tr>
<tr>
<td>Connect or Disconnect Individual Student Computers</td>
<td>39</td>
</tr>
<tr>
<td>Refresh a Student Computer</td>
<td>41</td>
</tr>
<tr>
<td>View System Information for Student Computers</td>
<td>41</td>
</tr>
</tbody>
</table>
Enter Comments About the Student Computer ........................................ 41
Remove Vision Icon from a Student Computer System Tray ............ 42

**Chat with Your Students** ......................................................... 44
Start a Chat Session with Your Students ...................................... 44
Create and Send Multiple-Choice Questions ......................................... 52
Chat Request Handling ................................................................. 55
About the Work File Directory ...................................................... 55

Exit Chat .................................................................................. 57

**Student Computer Access** ...................................................... 58
Lock and Unlock Student Computers ............................................... 58
Lock and Unlock Student Keyboards ............................................... 58
Receive Notification When a Teacher Tries to Connect to Your Class .... 59
Log Off from Vision ...................................................................... 60

**Screen Sharing** .................................................................. 61
Share Your Screen with the Classroom ........................................... 61
Share a student screen with the classroom (Virtual Teacher) ............ 62

**Supervision** ........................................................................ 65
Open the Supervision Window ....................................................... 65
Navigating Pages ......................................................................... 66
Adjusting the Number of Student Screens Per Page ..................... 66
Adjusting the Amount of Time Per Page ........................................ 67
Close Supervision ....................................................................... 67

**Remote Control** ................................................................... 68
Take Remote Control of a Student Computer .................................. 68
Improve Visibility of the Remote Control window .......................... 69
Lock and Unlock a Remote Controlled Student Computer ............ 69
Move Files by Dragging ................................................................ 70
Turn on Student Computers Remotely .......................................... 71

**Live Supervision** ................................................................ 75
Monitor a Student Computer in Real Time ..................................... 75
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Enrollment</td>
<td>78</td>
</tr>
<tr>
<td>Open Enrollment Process</td>
<td>78</td>
</tr>
<tr>
<td>Start an Open Enrollment Class</td>
<td>79</td>
</tr>
<tr>
<td><strong>Additional Vision Tools</strong></td>
<td>83</td>
</tr>
<tr>
<td>Pointer</td>
<td>83</td>
</tr>
<tr>
<td>To make screen annotations</td>
<td>83</td>
</tr>
<tr>
<td>Capture images with Snap</td>
<td>84</td>
</tr>
<tr>
<td>Capturing a Screen Shot in Remote Control or Live Supervision</td>
<td>84</td>
</tr>
<tr>
<td>Surf-Lock2</td>
<td>85</td>
</tr>
<tr>
<td>To lock and unlock access to the Web</td>
<td>85</td>
</tr>
<tr>
<td>Limit Web access to selected sites</td>
<td>86</td>
</tr>
<tr>
<td>App-Control</td>
<td>87</td>
</tr>
<tr>
<td>Launch an application on student computers</td>
<td>87</td>
</tr>
<tr>
<td>Kiosk an application on student computers</td>
<td>87</td>
</tr>
<tr>
<td>Share a document with students</td>
<td>88</td>
</tr>
<tr>
<td>Vision Teach-Pad</td>
<td>89</td>
</tr>
</tbody>
</table>
Welcome to Vision

Welcome to Vision, the easy-to-use Classroom Management solution designed to help you control student computer activity in your classroom or lab. With Vision Classroom Management you can track student computer use, share your screen with the class during instruction, and take control of a student's computer to help with a problem. Unlike a computer screen projector, Vision does not require any special hardware or wiring; all you need to run Vision is a network connection between computers.

This guide explains the Vision features used to manage a classroom. It also includes technical information about working in a wireless environment, configuring Open Enrollment classes, and customizing the program to suit your needs. For general information on the most common Vision features, refer to Vision Help or the Vision Getting Started Guide.

What’s New in Vision6 version 6.8

With Vision Classroom Management software, keeping your class secure, productive and engaged has never been easier. Vision6 version 6.8 provides several new exciting features outlined below.

**Target single student computers for remote installation**

The student software deployment wizard has been improved significantly. Now you are able to target specific computers in your classroom for software installation or update.

**Specify alternative credentials during remote installation**

In this new version of Vision, you are now able to specify alternative credentials for the software installation on student computers. As you need administrative rights for the remote installation and your personal credentials may not always have sufficient rights, you can use different credentials just during the remote software installation process.
Remote software uninstallation
The Vision Teacher module is now able to detect existing versions that are installed on student computers and offers the possibility to uninstall Vision student software remotely from all student computers of a classroom with a few mouse clicks.

Significantly improved connectivity
Local computer networks do not always have a perfect setup. If name resolution in your local network is not configured properly, the connection procedure from the Teacher computer to the student computers may take a long time.

This new version of Vision now offers a new preference that uses broadcasting on the Teacher computer in order to speed up the connection process significantly. As soon as all student computers are connected to the teacher, broadcasting is not needed anymore and broadcast traffic is reduced to zero.

Enabling or disabling Wake-on-LAN (WOL)
Vision now offers the possibility to enable or disable Wake-on-LAN when the teacher connects to a classroom. Sometimes teachers do not want to wake up all computers when connecting to a classroom, so they can now disable WOL in the Vision Preferences and leave unused computers switched off.

Improved license handling for Vision and plug-ins
Some users do not want to make use of all the plug-ins offered by Vision. You can now use the Vision Licensing Utility to activate or deactivate specific plug-ins. Deactivating a plug-in will remove the corresponding icon from the Vision toolbar.

Surf-Lock2: Enhanced compatibility with other 3rd party software
Occasionally applications such as Surf-Lock2, Firewalls and Anti-Virus software have conflicts because they all try to control activity on the computer. This release of Vision is avoids many of the conflicts that occur on networks running multiple applications of this type. Issues with Microsoft ISA Firewall and Symantec and Norton Antivirus software that occurred in previous versions have been addressed.

Vision@Hand - wireless control of your classroom
Vision@Hand is a unique new feature of Vision. Vision@Hand is the wireless version of our popular Teach-Pad. Teachers who have a mobile device with an Internet browser and have a local network that supports wireless access may now use their device as a wireless Teach-Pad and control their classroom with the most frequently used classroom management functions.
Technical Support

When you need additional support, contact our Technical Support Team by phone, e-mail, or through our Web site.

In North America

Phone: 866-725-7803 (toll free)
E-mail: support.us@genevalogic.com
Web: www.genevalogic.com
Our hours are 7:30 AM–4:30 PM Pacific Time.

All Other Locations

Outside of North America, the technical support of our products is provided through our international network of distributors and resellers. Please contact the local GenevaLogic distributor in your area. For a list of distributors, visit our international support page at www.genevalogic.com.
Install / Uninstall Vision

System Requirements
Before you begin to install Vision, verify that your network and classroom computers meet all of the following system requirements. You must also have a valid serial number to activate Vision, as well as valid serial numbers to activate any plug-ins you wish to use.

You can install a 30-day evaluation version without a serial number in order to test Vision and all plug-ins.

Network
The network must have the following minimum configuration:

- Wired Network: 10 Mbps full duplex; 100 Mbps or higher recommended.
- Wireless Network: 802.11b; 802.11g recommended
- Peer-to-peer name resolution enabled (e.g., DNS or other name server)

Computers
The classroom computers must have the following minimum configuration:

- **Operating System:** Vista Business, Vista Ultimate, XP Professional, and Windows 2000 Professional. 64 bit versions are **not** supported. Vision supports classrooms with a combination of operating systems.
- **Processor:** Intel® Pentium® III processor or equivalent; 500 MHz or higher
- **Memory:** 64 MB RAM; 128MB and higher recommended
- **Hard Disk:** 30 MB of available hard-disk space
- **Video Display:** Any 100% VGA compatible graphics adapter supported by Windows

**NOTE:** Vision requires that all connected computers be able to communicate with one another by computer name. If network
settings on a computer are changed, this may disrupt name resolution and cause Vision connections to fail.

**Ping** a student computer by name from the teacher computer, and then ping the teacher computer by name from a student computer. If the ping fails, contact your network administrator. If the ping succeeds but Vision does not function properly, contact Technical Support.

**Installation Instructions**

After you have verified that your network and classroom computers meet the system requirements, you can begin to install Vision. Vision requires that software be installed on both the Teacher and Student computers, and may be deployed in any one of 3 ways:

1. Manual installation on Teacher computer followed by automatic deployment to Students.
2. Manual installation of all components on Teacher and Student computers.
3. Deployment from a central management system.

**Method 1** is best for teachers who manage their own classroom computers.

**Method 2** is best for teachers or administrators who cannot deploy software from one computer to another due to security restrictions.

**Method 3** is best for administrators of medium to large networks who have deployment tools already in place. This procedure may be completely automated.

**Manual Installation of Vision Teacher**

Follow the steps below to install Vision on the Teacher computer. Once this is complete you may deploy software to the Student computers from the Teacher computer, or you may install the Vision software manually on each Student computer. Student installation instructions follow this section.

1. Log on to the Teacher computer as an administrator.
2. Exit all programs.
3. Exit all virus protection utilities.
4. Run the Vision Setup program.
   - If you are installing from a file that you downloaded, open the folder where you saved the Setup program, and then double-click `Vision6_68ENSetup.exe`.
   - If you are installing from a CD, insert the CD in the proper drive, point to `Vision`, and then select **Install Vision**.
5. Click **Next** to start the installation.

6. Read and accept the licensing agreement, then click **Next**.

7. At the **Customer Information** screen, enter your name and the name of your school or business.

8. At the **Setup Mode** screen, select **Install** then click **Next**.

9. At the **Setup Type** screen, select **Teacher** (Vision Master). All plug-ins are automatically installed with Vision. Click **Next**.

10. When presented with the option to enter license keys, enter keys for Vision and purchased plug-ins
   - If the license key is not entered during installation, Vision and all plug-ins will run in Trial mode for 30 days. Vision may be licensed at any time during or after this period.
   - If you have a license key for Vision, you may elect to run any plug-ins in Trial Mode by leaving the license field blank and selecting the “Start 30-Day trial” checkbox.
   - Plug-ins may be independently activated from the GenevaLogic Licensing Utility.

11. At the **Simple/Advanced** screen, select **Simple Installation** then click **Next**.

12. At the next screen, click **Install** to begin installing Vision.

13. After you complete the installation, you may immediately launch Vision by checking the “Launch Vision6” checkbox on the final installer screen. Be sure to restart any virus protection utilities that you use (it may be easiest to restart the computer). You are now ready to set up your classroom and begin to use Vision.

**Automatic Installation of Vision Student Software**

Once the installation of the teacher software is complete, you may create classrooms of student computers. Once these groups are defined on the Vision Teacher, you may install the Vision Student software directly to those computers from the Vision Teacher computer.

**NOTE:** When the Vision Teacher is run for the first time, you will be asked to create a classroom.

If you are upgrading from a previous installation of Vision, existing classrooms are preserved and may be used to deploy the new Student software. Please proceed to **Install Vision on Students in existing Classrooms**.
Create Your First Classroom and Install Vision on Student Computers

If this is the first time that Vision has been installed on this computer, you will be prompted to populate your Vision Classroom automatically. Once your first Vision Classroom is set up, you can use Vision to deploy the client software to the student computers.

**NOTE:** All student computers must have **Windows File & Printer Sharing** services enabled in order to install Vision remotely.

1. **To start Vision for the first time**, either check the “Launch Vision” checkbox at the end of installation, or double-click the Vision icon on your desktop.

2. A dialog will appear asking you to setup your Vision Classroom. Click **Yes**.

3. The Setup Classroom Wizard will open and guide you through the process. Click **Next** to continue.

4. When the Classroom Computers page appears, select the student computers you want to add to the Classroom. You can select computers in three ways.
   - Using the dropdown menu to choose a network Domain or Workgroup, browse for computers on your network that you wish to have in your Classroom. Use the arrows to move computers in or out of the Classroom.
   - Click the “Open Network” button to open Windows Explorer to browse for network computers. When you find the computers you want to use, drag them into the Classroom computers pane.
   - Click the “Add…” button to type in the names of Classroom computers.

**TIP:** Are your computers named to match your location? Enter a text string that matches the common text in the names of your classroom computers into the **Filter** box. Vision will automatically select all matching computers and display them in the Network. You may then use the **arrow** buttons to add or remove computers from your classroom.

5. Once you have populated your Classroom, click **Next**

6. When the **Ready to add student computers to your classroom** page appears, make sure that the **Take me to the Vision Deployment Wizard** checkbox is checked, then click **Finish**.

7. The Vision Deployment Wizard is launched.

8. Read the notes on the **Welcome to the Vision Deployment Wizard** page and click **Next**.
9. You must have administrative rights to install Vision software on student computers. Make the selection and add the alternative credentials if necessary, then click Next.

10. When the Install / Update Vision Student Software dialog appears, select the computers in your classroom targeted for the remote installation. Click Next.


12. When the Vision Student Software Installation dialog appears, the installation will begin automatically. Once the progress bar and log indicate that the process is complete, click Next.

13. When the final screen appears, click Finish to open your new Classroom.

NOTE: It will take a few moments for the student computers to complete installation before connection is complete.

Install or Update Vision on Students in existing Classrooms

If you have already established a Classroom, you can easily deploy Vision software to the student computers. If your student computers already have Vision installed, you can use this utility to upgrade them in a few quick steps.

NOTE: All student computers must have Windows File and Printer Sharing services enabled in order to install Vision remotely.

1. You have two possibilities to invoke the Vision Deployment Wizard:
   - Go to Manage Classrooms in the File Menu, select your classroom and click on Install / Remove...
   - Right-click in the dashboard view of your classroom and select Properties, go to the Clients List tab and click on Install / Remove...

2. Read the notes on the Welcome to the Vision Deployment Wizard page and click Next.

3. On the Install or Remove Vision Software page, choose Install / Update Vision on student computers and click Next.

4. You must have administrative rights to install Vision software on student computers. Make the selection and add the alternative credentials if necessary, then click Next.

5. When the Install / Update Vision Student Software dialog appears, select the computers in your classroom targeted for the remote installation. Click Next.
6. On the Confirm Installation / Update page, confirm your selection by clicking Install.

7. When the Vision Student Software Installation dialog appears, the installation will begin automatically. Once the progress bar and log indicate that the process is complete, click Next.

8. When the final screen appears, click Finish to open your new Classroom.

NOTE: It will take a few moments for the student computers to complete installation before connection is complete.

Manual Installation of Vision Students

Use this method to manually install Vision on each student computer, one at a time.

NOTE: This procedure may also be used to upgrade Student computers from previous versions of Vision.

1. Log on to each student computer as an administrator.

2. Exit all programs.

3. Exit all virus protection utilities or filters.

4. Run the Vision Setup program.
   • If you are installing from a file that you downloaded, open the folder where you saved the Setup program, and then double-click Vision6_68ENSetup.exe.
   • If you are installing from a CD, insert the CD in the proper drive, point to Vision, and then select Install Vision.

5. Click Next to start the installation.

6. Read and accept the licensing agreement, then click Next.

7. At the Customer Information screen, enter your name and the name of your school or business.

8. At the Setup Mode screen, select Install.

9. At the Setup Type screen, select Student (Vision Client). All plug-ins are automatically installed with Vision.

10. At the Simple/Advanced screen, select Simple Installation then click Next.

11. Follow the remaining instructions to complete installation.
After you complete the installation, restart the computer and any virus protection utilities that you use. You are now ready to set up your classroom and begin to use Vision.

**Manual Upgrade of Vision and plug-ins**

If you have already installed a previous version of Vision 6, you can upgrade to Vision 6 v6.8 while preserving your licenses, Classrooms and other settings.

**NOTE:** The Vision 6 installer automatically recognizes previous installations and will offer you the option to Upgrade.

The Upgrade option works on both Teacher and Student computers.

**NOTE:** Vision 5 can be updated but a new license key (VI60 or VI65) must be entered and the classrooms and settings are not retained.

**NOTE:** Installation of Vision 6 v6.8 will not remove existing versions Vision 4.1 or earlier. You must remove these versions manually.

If you have installed Vision plug-ins such as Surf-Lock or App-Control, this upgrade will affect them as well. All licenses will be preserved.

In Vision 6 v6.8, Vision and all plug-ins are treated as a single object. Add/Remove Programs will contain an entry for Vision 6 but not individual plug-ins, as they are now installed and removed together.

1. Log on to the network computer as an administrator.

2. Exit all programs.

3. Exit all virus protection utilities or filters.

4. Run the Vision Setup program.
   - If you are installing from a file that you downloaded, open the folder where you saved the Setup program, and then double-click `Vision6_68ENSetup.exe`.
   - If you are installing from a CD, insert the CD in the proper drive, point to Vision 6, and then select Install Vision.

5. Click Next to start the installation.

6. Read and accept the licensing agreement, then click Next.

7. At the Customer Information screen, enter your name and the name of your school or business.

8. On the next screen, choose the option to Upgrade.
9. Confirm this choice at the next screen to begin installation.

10. When complete, open the Classroom Manager from My Classrooms to upgrade your student computers. This is described above.

Remote Uninstallation of Vision Student software

With the new Vision Deployment Wizard, Vision Student software can now be removed remotely from the teacher computer without the need to do a manual uninstallation on each student computer.

To uninstall Vision Student software from computers within your classroom, follow the steps below:

1. You have two possibilities to invoke the Vision Deployment Wizard:
   - Go to Manage Classrooms in the File Menu, select your classroom and click on Install / Remove...
   - Right-click in the dashboard view of your classroom and select Properties, go to the Clients List tab and click on Install / Remove...

2. Read the notes on the Welcome to the Vision Deployment Wizard page and click Next.

3. On the Install or Remove Vision Software page, choose Remove Vision from student computers and click Next.

4. You must have administrative rights to install Vision software on student computers. Make the selection and add the alternative credentials if necessary, then click Next.

5. When the Remove Vision Student Software dialog appears, select the computers in your classroom targeted for the remote uninstallation. Click Next.

6. On the Confirm Removal page, confirm your selection by clicking Remove.

7. When the Vision Student Software Removal dialog appears, the uninstallation will begin automatically. Once the progress bar and log indicate that the process is complete, click Next.

8. When the final screen appears, click Finish to close the Vision Deployment Wizard.

**NOTE:** It will take a few moments for the student computers to reboot after the uninstallation has been completed.
Deploying Vision via Central Management

If you have a system in place that supports remote deployment of software to your Windows computers, you may use it to install Vision6 via MSI (Microsoft Installer) packages. Common remote deployment systems include Microsoft SMS/Group Policies, Novell ZENworks, Altiris Notification Server, etc.

Vision6 can easily create customized MSI packages that contain all options and licensing information, eliminating the need for complex installation switches.

**TIP:** Vision6 v6.8 offers an option to create an “Update MSI”. If you have already deployed Vision across your network, this package will update all versions of Vision without changing the type of installation (Teacher or Student) so you do not have to maintain separate lists of Teacher and Student computers.

Create a Vision6 MSI Installation Package

1. Run the Vision Setup program.
   - If you are installing from a file that you downloaded, open the folder where you saved the Setup program, and then double-click Vision6_68ENSetup.exe.
   - If you are installing from a CD, insert the CD in the proper drive, point to Vision 6, and then select Install Vision.
2. Click **Next** to start the installation.
3. Read and accept the licensing agreement, then click **Next**.
4. On the next screen, choose the option to Create MSI
5. On the following screens, enter options as you require (Student, Teacher, licenses, etc.)
6. When prompted to save the resulting files, choose a destination folder and click **Save**.
7. Exit the installer.

The Vision6 installer creates three files in the destination folder you have selected:
- Data1.cab
- ISScript1050.msi
- Vision.msi

All of these files must be placed together in a folder that is used by your deployment system for distribution to network computers.

Create a Vision6 MSI Updater Package

1. Run the Vision Setup program.
If you are installing from a file that you downloaded, open the folder where you saved the Setup program, and then double-click **Vision6_68ENSetup.exe**.

If you are installing from a CD, insert the CD in the proper drive, point to **Vision 6**, and then select **Install Vision**.

2. Click **Next** to start the installation.

3. Read and accept the licensing agreement, then click Next.

4. On the next screen, choose the option to **Create Update MSI**

5. On the following screens, enter options as you require (Student, Teacher, licenses, etc.)

6. When prompted to save the resulting files, choose and destination folder and click **Save**.

7. Exit the installer.

The Vision6 installer creates three files in the destination folder you have selected:

- **Data1.cab**
- **ISScript1050.msi**
- **Vision.msi**

All of these files must be placed **together** in a folder that is used by your deployment system for distribution to network computers.

**Running Vision6 MSI Packages**

Each deployment tool has its own set of rules and conventions, not covered here. Each system supports the execution of MSI packages with related command line switches that control different aspects of the installation.

**InstallShield Runtime**

The Vision6 installer is dependent upon the InstallShield runtime component. This component is automatically generated by the Vision6 installer and appears as a package always named **ISScript1050.msi**. This component must be installed prior to Vision6 in order to use an MSI package.

To deploy the InstallShield Runtime component, use the following command line in your deployment tool:

```cmd
msiexec /qn /i ISScript1050.msi
```

This will silently install the component on the targeted computers.

**Vision6 MSI Switches**

Once you are certain that the InstallShield Runtime component is in place, you may deploy Vision6. Vision6 MSI packages are usable without any special command line switches, but some options are helpful.
To ensure silent operation:
/qn
To force installation (and not other options)
/i

Example:
msiexec /qn /i vision.msi REBOOT=ReallySuppress
Plug-ins and Licensing

Vision6 Plug-ins

Vision6 incorporates plug-ins that expand the tools that you may use to manage your classrooms. In versions of Vision6 prior to 6.7, all plug-ins required separate installers and licenses. In Vision6 v6.7 and newer, all plug-ins are automatically installed with no additional steps. These automatically installed plug-ins require individual licenses in order to be fully functional, though you may run a 30 day trial of any of them at no cost.

Each plug-in has its own set of instructions. Below is a quick overview of Vision6 plug-ins and how to manage them.

Surf-Lock<sup>2</sup>

The Surf-Lock2 plug-in gives you full control over internet access in your classrooms. With one click you can disable all web browsing to get student’s attention and keep them on task. You may also create lesson-appropriate Site Lists in order to lock students into an easily defined set of approved websites.

App-Control

App-Control allows you to launch applications and documents on student computers, reducing the time it takes for your students to be ready for a lesson. You may also lock students into specific applications using the “Kiosk” feature.

Pointer

Pointer provides on-screen annotation for your lessons - especially valuable when using Vision’s Demo feature to share your screen with your students. You can highlight, hide, emphasize and add notes to presentations. Pointer also includes high quality screen capture tools that allow you to create screen shots of the teacher computer screen or a student computer screen.

Licensing

While Vision6 installs all plug-ins at once, they are not permanently available until they are licensed. Licensing of Vision6 and plug-ins can be done either via the Vision6 installer, or via the GenevaLogic Licensing Utility which is always installed on the teacher computer with Vision6.
**Licensing During Installation**

To license Vision6 and plug-ins during installation, be prepared with a copy of your license keys. GenevaLogic license keys are alpha-numeric strings that are easily sent via email or in a simple text file. It is best to have your keys in an electronic form so that you may easily copy and paste them.

**NOTE:** Only the Vision6 Teacher software requires a license. Student software is not licensed.

During manual installation of the Vision6 teacher software, a Licensing window will be presented:

- To run Vision6 and all plug-ins in 30-day Trial mode, simply leave the license fields blank. The Trial period will begin immediately.

- To license Vision6 and any plug-ins, enter a valid Vision6 license. The remaining license fields will become active in order to allow you to enter license keys for your plug-ins

**NOTE:** Even if you have a valid license for Vision6, you may still run any unpurchased plug-ins in 30-Day Trial mode. Simply leave the appropriate license fields blank and check the boxes labeled “Begin 30-Day Trial” by each one.

Once the installation is complete, the license keys you have entered for Vision6 and any plug-ins will be registered with the product. You may view and modify your licenses using the **GenevaLogic Licensing Utility** that is installed with the Teacher software, described below.
Licensing After Installation

Once Vision6 and any plug-ins are installed, licenses are easily managed via the GenevaLogic Licensing Utility.

To run the utility, navigate to **Start Menu -> All Programs -> GenevaLogic -> GenevaLogic Licensing Utility.**

Once open, all of your current licenses and their status are shown:

- **To add or update a license for Vision6 or a plug-in,** choose the item you wish to license in the main window and enter the new license key in the License Field. This is most easily accomplished via copy and paste from an email or text document.

- **To activate or deactivate a plug-in,** check or uncheck the **Status** checkbox. When a plug-in is deactivated, the respective icon is removed from the Vision toolbar.

**NOTE:** As soon as the trial period of a plug-in has expired, it can only be reactivated with a valid license key.

**NOTE:** You may only run a 30 day Trial once. If you require additional time to evaluate the product, please contact GenevaLogic sales.

**30-Day Trials**

Vision6 and all plug-ins are available for 30-Day Trial without the need for any license keys. Once this period is over, you will be notified via a pop-up window and any unlicensed products will cease to function.

If you wish to license Vision6 and plug-ins after the Trial period has ended, you do not need to reinstall the product. Simply open the GenevaLogic Licensing Utility as described above and enter your licenses to reactivate the product(s).
Expired Plug-ins

Many customers install a licensed version of Vision6 and then run a 30-Day Trial of a plug-in. When the Trial period for a plug-in ends, a pop-up window will appear when you attempt to use the plug-in feature reminding you that the Trial is over. If you dismiss this dialog and do not enter a license for the plug-in, it will “disappear” from Vision6.

**TIP:** You may reactivate any expired plug-in by entering a valid license for it using the GenevaLogic Licensing Utility, described above.
Setting Up Vision in the Classroom

In Vision you use classrooms to organize a group of student computers you want to monitor at one time. You can create a Vision classroom to represent a physical classroom or lab. You can also use classrooms to group computers at different locations, such as a school library. After you create a classroom and connect to it, you can begin to supervise student work, remotely control computers, share screens, lock keyboards, and use other Vision features.

You may create a classroom before or after installing Vision on the student computers, and you may use the Classroom Installer to deploy Vision to student computers as needed.

If you have updated or upgraded Vision, your previously existing Classrooms will be preserved; skip to Install Vision on Students with Classroom Installer to learn how to upgrade your Student computers directly from the Teacher computer if you have not already done so.

**NOTE:** Vision client software must be installed on the student computers in order to connect to a classroom.

**NOTE:** Create your classrooms before using the Classroom Installer to deploy Vision to student computers.

Create a Classroom

1. Double-click the Vision icon on your desktop to open the Vision Dashboard window.
2. On the Classroom toolbar, click the drop-down menu on the My Classrooms icon.

3. Click Manage Classrooms... The Manage Vision Classrooms window opens.

4. In the Manage Vision Classrooms window, click New. The Create Classroom wizard opens.

5. Enter the classroom name and any comments you want to include. Comments appear in the classroom properties.
   - To allow students of the class to log on to or opt out of classes at their own discretion, select the Open Enrollment Classroom check box. For more information about this option, see the chapter Open Enrollment Process.
   - To make this classroom your default classroom select the Make this Classroom my Default Classroom check box. Vision6 will automatically connect to this classroom when Vision starts.
   - To make this classroom available to all users who log in to this computer, select the Make this Classroom Global check box.*

6. Click Next. The Classroom Computers window opens.

7. Select the computers you want to add to the classroom. You can select computers in three ways.
- Using the dropdown menu to choose a network Domain or Workgroup, browse for computers on your network that you wish to have in your Classroom. Use the arrows to move computers in or out of the Classroom.
- Click the “Open Network” button to open Windows Explorer to browse for network computers. When you find the computers you want to use, drag them into the Classroom computers pane.
- Click the “Add…” button to add Classroom computers by their Windows names.

**NOTE:** If this classroom allows Open Enrollment, you cannot add computers from the network to the classroom. See the chapter **Open Enrollment** for more information.

**NOTE:** * You may only make a Classroom global if you are logged in as an administrator. Otherwise, you may only create Personal Classrooms that will only be available under your user account on the Teacher computer.

**TIP:** Are your computers named to match your location? Enter a text string that matches the common text in the names of your classroom computers into the Search box. Vision will automatically select all matching computers and display them in the Network. You may then use the “Move” buttons to add or remove computers from your classroom.

**TIP:** To remove a computer from the classroom, select the computer and click **Remove**.

8. Once you have added all the computers you wish to your Classroom, click **Next**.

9. On the final screen of this wizard, read the information and click **Finish** to finalize the creation of the classroom.

**NOTE:** After closing this wizard, you are done with adding student computers to your classroom. In order to connect to your student computers, you have to install the Vision student software on the computers. Go to the chapter **Install Vision on Students with Classroom Installer** on the next page to see how to do this.

### Rename a Classroom

1. Open the **Manage Vision Classrooms** window.

2. Click **Rename**. Type in your new name.
Delete a Classroom

1. Open the Manage Vision Classrooms window and select the classroom you want to delete.
2. On the File menu, click Delete.
3. In the Confirm Classroom Delete window, click Yes.

Install Vision on Students with Classroom Installer

The Classroom Installer allows a teacher to install, update, upgrade and restore Vision software on Student computers directly from the Teacher computer.

NOTE: If an older version of Vision is already installed on Student computers, you can choose between updating or removing the Vision student software. If Vision is not installed on Student computers, this procedure will install it.

1. Double-click the Vision icon on your desktop to open the Vision Dashboard window.

2. On the Classroom toolbar, click the drop-down menu on the My Classrooms icon.

3. Click Manage Classrooms... The Manage Vision Classrooms window opens.
4. Select the Classroom which you wish to deploy Vision software to.
5. Click the Install / Remove... button.
6. The Vision Deployment Wizard is launched.
7. Read the notes on the Welcome to the Vision Deployment Wizard page and click Next.
8. On the Install or Remove Vision Software page, choose Install / Update Vision on student computers and click Next.
9. You must have administrative rights to install Vision software on student computers. Make the selection and add the alternative credentials if necessary, then click Next.

10. When the **Install / Update Vision Student Software** dialog appears, select the computers in your classroom targeted for the remote installation. Click Next.

11. On the **Confirm Installation / Update** page, confirm your selection by clicking **Install**.

12. When the **Vision Student Software Installation** dialog appears, the installation will begin automatically. Once the progress bar and log indicate that the process is complete, click **Next**.

13. When the final screen appears, click **Finish** to open your new Classroom.

**NOTE:** It will take a few moments for the student computers to complete installation before connection is complete.
Configure Vision for Wireless Networks

Vision contains settings to optimize your Classroom connection depending upon your type of network. By default Vision is optimized for a standard “wired” network. If you are using Vision6 in a wireless environment (802.11b, 802.11g or 802.11n) do the following:

1. Right-click the Vision icon on your desktop and choose Vision Preferences from the menu.
2. In the preferences window, click the icon labeled **Network**.

3. In the topmost dropdown menu, choose **Wireless LAN**.

4. Click **OK** to close **Vision Preferences**.

Vision6 is now configured for use in Wireless environments.

**Connect to a Classroom and Monitor Student Computers**

After you connect to a classroom, you can monitor the computer activity of all student computers from the dashboard. Vision automatically connects to your default classroom when started; this setting may be changed in **Vision Preferences**.

1. Double-click the **Vision** icon on your desktop. The **Vision** window opens to display the default classroom.

2. If Vision is *not* configured to connect automatically, click the **Connect Classroom** button on the **Classroom** toolbar.
The student computer thumbnails display the student computer screen when the students connect to your computer.

To Disconnect from a Classroom
To disconnect from a classroom and stop managing your students, click the Disconnect Classroom button.

Add or Remove a Student Computer from a Classroom

1. Open the Vision window.
2. Open the Manage Vision Classrooms window.
3. Select the classroom you want, and then click the Properties button. The Classroom Properties window opens.
4. Click the Clients List tab and select the student computer you want to add or remove.
   - To add a computer to the classroom, locate the computer in the Network Computers pane, select it and use the right arrow button to move it into your Classroom.
   - To remove a computer from the classroom, select it in the Classroom Computers pane and click the left arrow button.
5. When you finish, click OK and close the Classroom Properties window.

Connect to a Different Classroom
If you have configured more than one Classroom in the Classroom Manager, you may connect to any of the Classrooms you have created.
1. On the Classroom toolbar, click the drop-down menu on the My Classrooms icon.

2. Choose the Classroom to which you want to connect.

3. Confirm selection in dialog that appears by clicking OK.

4. Vision will disconnect from the previous Classroom and connect to your selection.

**NOTE:** The currently connected Classroom is displayed in **bold type** in the My Classrooms drop down menu.

**Export a Classroom**

You can export your classroom to other teachers who use Vision.

1. Open the Manage Vision Classrooms window, select the classroom you want to export, and then click the Export button.

2. If you want to save the classroom in a different folder, locate and open the folder.

3. If you want to change the name of the classroom, type a new name in the File name box.

4. Click Save, and then OK to close the Manage Vision Classrooms window.

**Import a Classroom**

You can import classrooms that other teachers use. These classroom must first be exported into files as described above.

1. Open the Manage Vision Classrooms window.

2. Click the Import button.

3. Locate the classroom you want to import. Classroom definition files use the extension *mecrd*.
4. Click **Open**. Vision disconnects you from a classroom if you have one open.

5. In the message that appears, click **Yes** to replace your current classroom with the one you are importing. Click **No** to merge the imported classroom with the others you have on your computer.

**Exit Vision**

- From the Vision window, point to **Tools**, click **Security**, and then click **Exit Vision**.

**NOTE:** When you turn on your computer again, Vision starts automatically.
Vision Windows and Toolbars

You can access most Vision features from one of the following two components: the Vision dashboard, which displays the student computers in a selected classroom; and the Vision toolbar, which you use to access Vision commands as you manage your classroom. Each of these components is described in detail below.

**About the Vision Dashboard**

The dashboard displays the active classroom on your computer. Using the dashboard, you can connect to the classroom and monitor student computers.

1. Settings, Views, My Views and Special Commands panes
2. Classroom area (in Thumbnails view)
3. Monitor pane

4. Groups pane

Open the Vision Dashboard

Double-click the Vision icon on your desktop.

NOTE: If Vision is already connected to a Classroom, you may select the My Classroom button in the Vision Floating Toolbar to open the Dashboard

Working with Panes Overview

You can adjust the areas or panes that border the student computer display on the dashboard (the Settings, Monitor, and Groups panes). You can keep the panes open or closed at all times or you can open the panes automatically when you point to the area of the dashboard where those panes are located.

Display or Hide Panes

- If you are using the Auto-Hide feature, point to a pane to open it. Point away from the pane to close it.

- If you are not using the Auto-Hide feature, click the open and close buttons, which appear in the upper left or right corner of the pane.

Turn On or Off Auto-Hide Panes

- Select the Auto-Hide check box to open panes automatically when you point to them.
• Clear the Auto-Hide check box to open and close panes when you click the open and close buttons. (These buttons appear in the upper left or right corner of the pane).

Change the Height or Width of a Window Pane
Point to the border of the pane, such as the Monitor or Groups pane. When the pointer changes into a double-headed arrow, drag the border to change the size of the pane.

About the Vision toolbar
The Vision toolbar appears at the top of your screen, on the Vision window, and on the dashboard. You use its buttons to start Vision features, such as Demo and Remote Control. If you use other GenevaLogic products, such as Surf-Lock or Pointer, the buttons for those products also appear on the toolbar.

About the Floating Toolbar
The toolbar at the top of your screen gives you an unobtrusive way to access Vision commands. You can easily start a demonstration or block student screens while you teach, without using the dashboard. Drag the toolbar anywhere on your desktop or customize it in any of the following ways to suit your needs. The changes you make are stored in your user profile and do not appear for other users.

Show, Hide, or Close the Vision Floating Toolbar
• If you are using the Auto-Hide feature, point to the top of the screen to view the toolbar. Point away from the toolbar to hide it.
• If you are not using the Auto-Hide feature, the toolbar remains at the top of the screen.
• Right-click the Vision toolbar, and then click Close the Shortcut Bar to remove it from your desktop.

Restore the Vision Floating Toolbar to Your Desktop
1. Right-click the Vision icon on your desktop and point to Options.
2. Click Use Shortcut-Bar.
Add Toolbar Buttons

**NOTE:** Your changes apply to the floating toolbar. You cannot add toolbar buttons to the Vision toolbar on the dashboard.

1. Right-click the floating toolbar and select **Customize**.

2. From the **Customize Toolbar** window, click the Vision icon in the **Command Categories** box.

3. From the **Commands** box, drag a command button to the toolbar.

**TIP:** You can also drag a button to your desktop.

Remove Toolbar Buttons

Right-click a button on the toolbar and select **Remove Button**.

Change Button Appearance

- Right-click the toolbar, and then click the option that you want to add or remove.
  - **Show Big Icons** increases the size of the toolbar buttons.
  - **Text Labels** displays names for each of the toolbar buttons.

Restore the Vision Toolbar to Its Original Look

Right-click the toolbar, and then click **Reset Vision**.

**Classroom Views**

There are three ways you can view your student computers from the dashboard: as thumbnails, in a list, and in a three-dimensional layout.

**Thumbnails View**

Below is an example of a classroom in Thumbnails view. You can move computers in this view to mimic the physical layout of your classroom.

Vision cycles through your classroom computers and refreshes one screen every three seconds, unless you have changed the refresh rate.
Details View

Below is an example of a classroom in Details view.

<table>
<thead>
<tr>
<th>Requested name</th>
<th>Status</th>
<th>Active application</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vincent</td>
<td>Available</td>
<td>Desktop</td>
<td></td>
</tr>
<tr>
<td>Paloma</td>
<td>Available</td>
<td>Calculator</td>
<td>CPU 4500</td>
</tr>
<tr>
<td>Takashi</td>
<td>Available</td>
<td>Desktop</td>
<td></td>
</tr>
</tbody>
</table>

Customize Details View

1. On the dashboard, open the Settings pane.

2. Under Choose Details, select the options you want to see when your classroom is in Details view.
   - **Status**
     Use this option to see what student computers are connected (Available) and disconnected (Vision client not found).
   - **Active application**
     Use this option to see the name of program the student is currently using.
   - **Comments**
     Use this option to see any comments that were added to the Vision properties of the student computer.
Perspective View

Below is an example of a classroom in Perspective view. Vision automatically cycles through the computers and displays each one in a larger view for a few seconds.

Adjust the Perspective View

You can adjust the Perspective view to see the classroom at a different angle.

In the Perspective view, click the Projector icon and move it down to decrease or up to increase the overhead perspective of your classroom.

Change How You View Your Classroom Computers

1. On the dashboard, open the Views pane.
2. Select the view you want: Details, Thumbnails, or Perspective.

NOTE: When you initially connect to a classroom, student computers appear in Thumbnails view.

Save or Remove a Customized View

After you arrange your classroom the way you want it to look, you can save your view for use the next time you connect to the classroom.

NOTE: Vision remembers the last view or arrangement of your classroom. Use this procedure when you have multiple views of a classroom.

1. Arrange the classroom how you want it to look. You can do any of the following:
   - Customize the dashboard background.
• Select a new classroom view.
• Move student computers to mimic the setup of your classroom.

2. On the dashboard, open the My Views pane.

3. Click Add view.

4. Type the name of your view and click OK. The name appears in this list of views and is available the next time you connect to this classroom.

   **NOTE:** To delete a view you no longer need, select that view in the My Views pane and click Remove view.

---

**Change the Image Size of a Student Computer**

You can adjust the size of the student computers that appear in the Thumbnails and Perspective views.

1. On the dashboard, open the Settings pane.

2. Click the View slider and move it to the right to increase or to the left to decrease the size of the classroom computers.

---

**Zoom In On a Student Computer**

Do one of the following to view a student computer more closely:

• Point to a computer to enlarge it temporarily.

• Drag a computer to the Monitor pane.

• View the classroom in Perspective view.
Working with Student Computers

Vision includes a number of functions to help you manage your student computers individually or as a subset of your classroom. You can associate each computer with a student, select individual computers to monitor more closely, and open the Vision properties of a student computer from your computer in order to make changes.

**Associate Each Classroom Computer with a Student**

To help you match the computers on your screen to the students in your classroom, you can send a message that asks students to sign in. Students enter their names which then appear next to the computers in the dashboard.

1. On the **Vision** toolbar, click the **Request user name** button.

The **Vision Enter user name** window appears on each student computer.
2. Students enter their names and click OK.

Each computer in the classroom is labeled with the name the student typed.

Select a Type of Display Name for Student Computers

Display names help you associate your classroom computers with a student, computer logon, or network address. You can change the type of display name.

- From the dashboard, on the View menu, point to Display name and click the view you want.
  - Default displays the computer name stored in the computer’s system properties.
  - Login displays the user name the student entered when he or she logged on to Windows.
  - Requested displays the name the student entered in the Vision-Enter user name window. If you did not request that your students enter a name, the word Empty appears next to the computer’s domain name.
  - Network address displays the Internet Protocol (IP) address.

Select One or More Student Computers

You can demonstrate a procedure to certain students who need help while other students continue working. To do this, you first select the individual student computers you want, and then click the Vision command.

To select individual computers, do one of the following:

- To select a single computer, click it.
- To select consecutive computers, click in a blank area of the dashboard, and then drag your mouse pointer over the computers you want to include.
- To select nonconsecutive computers, press and hold down CTRL, and then click each computer you want.
• Point to a student computer and click the **Check mark** button. Do this for each computer you want to select.

![Click this button to select a student computer.](image)

• Click on a group in the Groups pane. Groups are subsets of student computers that you create within a classroom. Instructions on how to create a group are below.

**TIP:** If you want to clear your selection of student computers, click in a blank area of the dashboard.

**Create a Group of Student Computers**

1. On the dashboard, in the **Views** pane, select **Thumbnails**.
2. In the **Groups** pane, click **New Group**.
3. Type a name for the group.
4. Select the computers you want to include in the group.
5. Click one of the selected computers and drag it to the new group. Vision adds all the selected computers to the group.

**Tips**

• You can also drag the computers you want to the Groups pane to create a group.

• To add another student computer to an existing group, drag it to that group.

**To Remove a Computer from a Group**

1. In the **Groups** pane, select the group from which you want to remove a computer. The computers in that group appear dimmed to indicate they are selected.
2. Point to one of the selected computers in Thumbnails view and click the **Delete from group** button.

Delete a Group Of Student Computers

In the **Groups** pane, drag a group to the **Delete Group** icon.

**Connect or Disconnect Individual Student Computers**

On the dashboard, you can connect or disconnect individual student computers. For example, if you connect to a classroom with 25 computers, but only 20 students are present, you can disconnect the five computers that are not in use.

**To Connect to a Student Computer**

1. Select a student computer.
2. On the **Special Commands** pane, click **Join student** button.

**To Disconnect a Student Computer**

1. Select a student computer.
2. On the **Special Commands** pane, click **Dismiss student** button.

**Monitor Selected Classroom Computers**

After you connect to a classroom, you automatically see the screen of every classroom computer. You can then select to monitor certain computers more closely in the **Monitor** pane. This is useful if you have a large class and want to pay attention to the students who need the most assistance or supervision.
To Display a Student Computer in the Monitor Pane

- Drag a student computer to the Monitor pane.

To Remove a Student Computer from the Monitor Pane

Click the Close button in the upper left corner of the student computer.

**NOTE:** Up to ten student computers fit in the Monitor pane.

Vision refreshes one screen every five seconds. You can change this refresh rate for the Monitor pane. Click on Appearance in the Settings pane on the left side of the dashboard to change the refresh rate.
**Refresh a Student Computer**

In **Thumbnail** view, point to a student computer and click the **Refresh** button.

![Refresh button](image)

**View System Information for Student Computers**

1. On the dashboard, put your classroom in **Thumbnail** view.

2. Point to a student computer and click the **Properties** button.

![Properties button](image)

3. Click the **System Information** or the **Vision Client** tab to view information such as the operating system or IP address of the student computer.

**Enter Comments About the Student Computer**

You can enter comments about the student computer from your computer. These comments appear next to the student computer when you view it in **Details** view.

1. On the dashboard, put your classroom in Thumbnails view.

2. Point to a student computer and click the **Properties** button.

![Properties button](image)

3. Click the **Vision Client** tab.
4. In the Comments box, enter any information you want to include about the student computer. These comments appear next to the student computer in Details view.

Remove Vision Icon from a Student Computer System Tray

From the dashboard you can remove the Vision icon that appears in the student computer system tray (the notification area at the far right of the taskbar).

1. On the dashboard, put your classroom in Thumbnails view.
2. Point to a student computer and click the Properties button.
3. On the Vision Client tab, clear the Display icon in Taskbar check box.
4. Click OK.
Chat with Your Students

From Vision, you can conduct an online chat session with your students. This is useful when you want to conduct a discussion with part of your class without disrupting other students as they work. For additional information about chat sessions and other features, refer to Chat Help.

**Start a Chat Session with Your Students**

1. On the **Vision** toolbar, click the **Chat** button.

2. On the **Chat** menu, click **New session**.

3. Enter a name for the session.
4. Select the students you want to include in the chat session from the **Available users** list, and then click the arrow button (>) to move them to the **Selected users** list. Next, click **Create**.

**TIP:** To chat with your entire classroom, click the **Chat with classroom** button.

5. Under **Enter your message**, type your message, and then press ENTER. Your students can also type messages and send them to you. As you continue your chat session, the Chat history area displays your discussion.

6. When you finish, click the **End Session** button or click the **Close** button in the upper right-hand corner.

---

**Start a Chat Session from a Student Computer**

1. From the student computer, right-click the Chat icon in the system tray (the notification area at the far right of the taskbar).
2. Select **Chat Request**.

3. In the **Chat Request** window, the message, “I need your help” appears. You can edit this message.

4. When you are finished typing your message, click **Send**.

**NOTE:** By default, the chat request feature is turned off and the following message appears when students submit a request. For information on how to turn this feature on, see “Control Student Access to Chat Features” on page 54.
Respond to a Student’s Chat Request

1. When a student submits a chat request, a New Chat Request window appears. Click Open queue to view a list of requests.

![New Chat Request Window](image)

The Chat requests window opens and displays all current chat requests.

![Chat Requests Window](image)

2. Select the name of the student and do one of the following:
   - Click the Reply button to send a single, private reply to the student.
     ![Reply Button](image)
   - Click the Chat button to begin a chat session with the student.
     ![Chat Button](image)
   - Click the Reject button to decline the chat session.
     ![Reject Button](image)
   - Click the Delete button to remove the request from the list.
     ![Delete Button](image)

Send and Collect files from Students

You can send files to your students and later collect them. Distribute tests, forms, or assignments to students for a certain amount of time and then collect them at the end of class.

**TIP:** In Remote Control you can drag files between your computer and the student computers. To enable or disable this setting, please go to Remote Control pane in the Tools -> Vision Preferences menu.
To Send a File to Students

1. In the Chat window, click the Send message button.

2. Type your message and select the file you want to send your students. Click Browse to search for the file.

   ![Send message window]

   - Enter message
   - File attachment: Reading/questions.doc

   - Recipients:
     - Available users: Nicole, Chris, Peter, Tom, Alex
     - Message Recipients: Nicole, Chris, Peter, Tom, Alex

3. Select the students you want to receive the file from the Available users list, and then click the arrow button (>) to move them to the Selected users list.
4. Click **Send**.

The students receive a message with the file attached to it. They double-click the file to open it.

**TIP:** Students can also find sent files in their Vision work directories by right-clicking the **Chat** icon in the system tray (the notification area at the far right of the taskbar) and clicking **Display work files**. The work directory opens.

**NOTE:** The location of your sent and received files is different depending upon the operating system and type of Vision software (Teacher or Student) installed.

For Windows XP:

Teacher: **Drive:**\Documents and Settings\yourloginnname\Documents\Chat** where **yourloginnname** is the name you use to log on to the computer.

Student: **Drive:**\Documents and Settings\All Users\Documents\Chat

For Windows Vista:

Teacher: **Drive:**\Users\yourloginnname\Documents\Chat** where **yourloginnname**
**yourloginname** is the name you use to log on to the computer.

Student: **Drive:\Users\Public\Documents\Chat**

### To Collect a File from Students

1. In the Chat window, click the **Collect** button to gather the files on the student work directories and move them to your teacher work directory. (Chat installs your the teacher work directory at **Drive:\Documents and Settings\yourloginname\Documents\Chat** where **yourloginname** is the name you use to log on to the computer.

   ![Collect button](image)

2. In the Collect Files window, indicate what should happen to the files after you collect them. You can delete the files from the student computers or leave them there. Chat then collects any student files that are stored in the Chat work files directory.

   ![Collect Files window](image)

### To Set a Timed Collection

When you send files you can schedule a time to collect them from the student computers.

1. In the Chat window, click the **Timed Collection** button.

   ![Timed Collection button](image)

2. In the Collection Time window, select the name of the student for whom you want to set a collection time and then click the **Set time** button.

   ![Collection Time window](image)
3. Enter the amount of time to wait before the files are collected from that student, and then click **OK**.

![Collect work files](image)

The **Collection time** window displays the time at which the student work file will be collected.

![Collection time](image)

---

**About the Question Pool**

During class, students can send you questions anonymously without disrupting the class or your lecture. Student questions are stored in the Question Pool, where you can check them off the list as you answer them. To send questions to the teacher, the students must have access to the Chat right-click menu. For more information, see “Control Student Access to Chat Features” on page 54.

**To Ask the Teacher a Question from a Student Computer**

1. From the student computer, right-click the Chat icon in the system tray (the notification area at the far right of the taskbar).

2. Select **Send question**.
3. In the **Send Question** window, type your question, and then click **Send**.

![Send Question window](image)

**To View Student Questions**

1. In the **Chat** window, click the **Question Pool** button.

![Question Pool window](image)

2. The **Question Pool** window lists all the questions that students have sent. Use the buttons in the toolbar to check, uncheck, or delete questions from the pool as you answer them.

**Create and Send Multiple-Choice Questions**

Use the Questions Manager to get feedback from students and to gauge their learning comprehension.

1. In the **Chat** window, click the **Questions Manager** button.

2. In the untitled question window, type your first question into the top pane.
3. Click the **New Answer** button to create an answer line in the bottom pane. Repeat this step until you have added all the possible answers to the question.

**TIP:** Click the **Save** button to store the question for future use.

4. When you are ready to send the question to your students, click the **Send** button.

5. The question appears on the student screens. Students select an answer, and then click **Send**.

As the students send in their answers, your screen displays the question window with a pie chart and list showing how the students answered.

**Ask Students for Feedback**

You can use Chat to send the class a survey to that measures the mood of your students, the complexity of your material and the speed at which you are presenting information. Student responses to the survey are anonymous; votes are not associated with a specific student.
1. On the Chat window, click the Feedback Statistics button.

2. On the Feedback Statistics window, click the Force Vote button.

The Feedback window appears on the student screens. Students respond to the survey and click Close.

The Feedback Statistics window displays the results of your survey. The number of students who did not provide feedback are recorded in the Unknown box.

**TIP:** Click the Reset button to clear the results of the survey.

**Control Student Access to Chat Features**

You can control whether students can start chat sessions with you or each other, send one time messages to you or each other, or have access to the Chat menu from their computers.
To Allow Your Students to Initiate Chat Sessions with You
From the Chat toolbar, click the **Reject all chat requests** button to turn this option on or off.

When you turn this option off, students see a Chat icon appear in the system tray (the notification area at the far right of the taskbar).

To Allow Your Students to Send Messages to Each Other
From the Chat toolbar, click the **Enable send** button to turn this option on.

To Remove the Chat Icon from the Student System Tray
From the Chat toolbar, click the **Disable clients** button. The Chat icon is removed from the student taskbar.

**Customize Chat**

**Chat Request Handling**
You can customize chat to decline all student chat requests.

1. In the **Chat** window, from the **View** menu, click **Options**.
2. In the **Properties** window, on the **Chat Request Handling** tab, select the **Reject all Chat Requests** check box to decline all student chat requests automatically.
3. In the **Display Text** box, enter the text that appears on the student computer when you decline a student request.

**About the Work File Directory**
Chat installs teacher and student work directories at Drive:\Program Files\GenevaLogic\Vision\Chat\WFiles. When you send and collect files to students, Chat uses this directory to store the files. You can change the directory location.

**To Change the Teacher Work File Directory Location**

1. In the **Chat** window, from the **View** menu, click **Options**.
2. In the **Properties** window, on the **General** tab, enter a new location for the work files in the **Work files path** box. Click **Browse** to search for a file folder.

![Properties window](image)

**To Change the Student Work File Directory Location**

1. In the **Chat** window, from the **View** menu, click **Options**.
2. In the **Properties** window, on the **Work files folder destination** tab, click **Users**.

![Properties window](image)

3. In the **Individual work files folder definition** window, right-click the name of the student whose work file directory you want to change, and then click **Set work files path**.

![Individual work files folder definition](image)

4. Enter a new location for the work files in the **Work files path** window and click **Set**. The path you enter will be used the next time you send and collect student work files.
Exit Chat

When you exit Chat, you close the Chat window on your computer as well as remove the Chat icon from the student and teacher taskbars.

- From the File menu, click Exit.
Student Computer Access

Vision offers a number of ways that you can control student computers, such as blanking screens and locking keyboards to keep your class focused during lessons or discussions.

Lock and Unlock Student Computers
You can lock the computers in your classroom to prevent students from using them. Vision displays a blank screen on the classroom computers and students cannot access their keyboards or mouse devices.

- On the Vision toolbar, click the Blank screen button.

- To unlock student computers, click the Stop button.

**TIP:** To unlock one or more student computers, while the other computers remain locked, select the computers, click the arrow next to the Stop button, and then click **Blocking**.

Lock and Unlock Student Keyboards
You can lock student keyboards when you want students to see their computer screens, but not have access to the keyboard or mouse.

- On the Specials Commands pane, click **Block User Input**.

- To unlock the keyboards, click the Stop button.
Receive Notification When a Teacher Tries to Connect to Your Class

You can receive a message when another instructor attempts to connect to a classroom or student computer that you are currently monitoring. This message asks you if want to allow the instructor to connect to the classroom or student, thus disconnecting you.

1. Double-click the Vision icon on your desktop to open the **Vision Dashboard**, or select the **Vision Floating Toolbar** if Vision is already running.

2. From the toolbar, select the **My Classrooms** drop down menu and choose **Manage Classrooms...** to open the **Classroom Manager** window.

3. Select the classroom you wish to edit and press **Properties**.

4. On the **Connectivity** tab, select **Ask for permission**.

**NOTE:** To automatically allow an instructor to connect to your class or student, and disconnect you, select **Automatically Accept**.

To automatically deny an instructor access to your class or student, select **Automatically Deny**.
**Lock and Unlock Vision on the Instructor Computer**

You can lock Vision to prevent others from accessing the program. Other open files and programs will still be available.

**To Lock Vision**

On the **Tools** menu, click **Security**, and then click **Lock Console**.

**To Unlock Vision**

1. On the **Tools** menu, click **Security**, and then click **Unlock Console**.
2. If you use a password to open Vision, type your user name and password.
3. Click **OK**.

**Log Off from Vision**

When you log off, the Vision toolbar still appears, but you are unable to work with student computers.

**To Log Off from Vision**

On the **Tools** menu, click **Security**, and then click **Log Off**.

**To Log On to Vision**

1. On the **Tools** menu, click **Security**, and then click **Log On**.
2. If you use a password to open Vision, type your user name and password.
3. Click **OK**.
Screen Sharing

When you are connected to a classroom, you can share your screen with the entire class as you demonstrate a procedure or present information to your students. Unlike a projector that displays your screen to the front of the classroom, Vision projects your computer screen to the individual screens of your students. Students have a front row seat to your presentation no matter where they sit in the classroom.

Share Your Screen with the Classroom

1. On the Vision toolbar, click the Demo button.

Your screen appears on the classroom computers. Full-screen is the default mode.

2. To minimize or maximize the window that appears on the student screen, click the drop down arrow next to the Demo icon for a drop down menu:
   - **Minimized Demo** - reduces the window to a button on the student taskbar. Students have access to the demonstration screen, but are not required to view it; they have access to their keyboards and mouse devices.
   - **Demo in Window** - makes your screen a window on the student computers. Students have access to your screen, but are not required to view it; they have access to their keyboards and mouse devices.
   - **Full-screen Demo** - maximizes the window so it covers the entire student screen. Student keyboards and mouse devices are locked.

3. To turn off the demonstration, click the Stop button.
Share a student screen with the classroom (Virtual Teacher)

In the same way you use the Demo button to share your screen with your class, you use the Virtual Teacher button to share a student screen with other students. This feature allows students to show their work to the class from their computers.

1. On the dashboard, click on a student computer to select it, and then click the Virtual Teacher button.

or

Click the arrow next to the Virtual teacher button and select the student computer you want.

The student screen appears on the other classroom computers, including yours. The other student keyboards and mouse devices are locked.

**TIP:** If you cannot see the student screen on your desktop, click the Virtual Teacher button in the taskbar.

2. To turn off the demonstration, click the Stop button.

Demo Toolbar for Students

When you share your screen with students in a Minimized Demo window, a Demo toolbar appears on the student screens. They can use this toolbar to adjust the appearance of the Demo window. To enable or disable the appearance of the toolbar, go to the Demo pane in Tools -> Vision Preferences.

- Click the Fit to window button to resize the instructor screen to fit the entire Demo window.

- Click the High quality mode button to make details of the Demo window easier to see.

- Click the Copy Screen button to copy an image of the entire Demo window to the Clipboard.
• Click the **PanView** button to open the Pan tool. A box that represents a view of the demonstration screen appears. Using your mouse, you can click on this box to pan throughout the demonstration screen.

![PanView icon](image)

• Use the slider to adjust the size of the Demo window.

![Slider image]
Supervision

The Supervision feature provides greater visibility when observing several student screens at one time. Supervision launches directly from the Vision toolbar in a separate window, allowing you to use the Vision dashboard while viewing student computers.

Open the Supervision Window

1. Double-click the Vision icon on your desktop to open the Vision window.

2. On the classroom toolbar, click on the **Supervision** icon. The **Supervision** window opens and the student screens appear.

**NOTE:** Supervision does not allow you to arrange the student screens but automatically arranges them and adjusts the number of pages required to display all student screens at a selected size.
Navigating Pages

When multiple pages are required, you can manually use the arrows in the Supervision toolbar to go to the previous and next page.

Adjusting the Number of Student Screens Per Page

Open the Supervision window. Go to the Supervision toolbar.

Vision offers three methods of adjusting the number of images per page from the Supervision toolbar:

- **Fewer Items Per Page** icon - clicking the icon will automatically decrease the number of items per page by one.

  ![Fewer Items Per Page](image)

- **More Items Per Page** icon - clicking the icon will automatically increase the number of items per page by one.

  ![More Items Per Page](image)

- Slider - you can manually adjust the number of items per page by moving the slider.

**NOTE:** The minimum usable image size is fixed and the maximum number of images is calculated based on the size of the
monitor you are using. This allows a large screen to display more images than a small screen, with no maximum limit.

You can adjust the size of the student screen to see just one per page or several on a page. The maximum size is one student screen per page. The minimum size is approximately 150 x 112 pixels.

Supervision always shows the entire screen - no partial views allowed.

**Adjusting the Amount of Time Per Page**

Open the Supervision window. Go to the Supervision Toolbar.

Vision offers three methods of adjusting the amount of time to view each student screen before automatically displaying the next page:

- **Less Time Per Page** icon - clicking the icon will automatically rotate the pages more quickly.

- **More Time Per Page** icon - clicking the icon will automatically rotate the pages more slowly.

- **Slider** - you can manually adjust the amount of time it takes to change a page.

To stop the rotation, click the **Page Advance** icon. It also restarts the rotation.

**NOTE:** The amount of time per page is from 3 to 15 seconds. You can also set the page to not rotate at all. Mini Vision Toolbar.

The Supervision toolbar also contains buttons for the following Vision functions:

- Demo
- Remote Control
- Virtual Teacher
- Live Supervision
- Blank Screen
- Stop

**Close Supervision**

Click the **Supervision** icon then select **close**. Or, close the **Supervision** window using the Windows **Close** button in the upper right-hand corner.
Remote Control

Using the remote control feature, you can help any student through a tough problem from your desk or take control of the student’s computer to log on, start a computer program or demonstrate a solution.

Take Remote Control of a Student Computer

From the instructor computer, you can open the Remote Control window, which displays the student’s screen. Use your mouse to control the student's computer. The student does not have access to the mouse or keyboard while you have remote control of the computer, unless you grant the student access.

Start Remote Control of a Student Computer

Use the following method to take control of a student computer:

- Select a student computer in the dashboard, and then click the Remote Control button.

- Click the arrow next to the Remote Control button and select the student computer.

**TIP:** If you cannot see the student screen on your desktop, click the Remote Control button in the taskbar.
Stop Remote Control of a Student Computer

- In the Remote Control window, click the Stop mode button.
- In the Remote Control window, click the Close button in the upper-right corner of the window.

**Improve Visibility of the Remote Control window**

When you have control of a student computer, you can adjust the appearance of the student screen that appears on your computer.

- Click the Fit to window button to resize the student screen to fit the entire Remote Control window.
- Click the High quality mode button to make details on the student screen easier to see.

**NOTE:** The High quality mode button is available after you select the Fit to window button.

**Lock and Unlock a Remote Controlled Student Computer**

When you have remote control of a student computer, you can lock and unlock the keyboard and mouse.

In the Remote Control window, click the Disable remote user input button.

**Share a Remote Controlled Student Screen with the Classroom**

As you demonstrate a procedure on a student computer, you can broadcast your actions to the rest of the class.

1. From the Remote Control window, click the Remote Control with Demo button.

The student screen you have in control appears on the classroom computers.
2. To minimize or maximize the window that appears on the other classroom computers, click the drop down arrow next to the Demo icon for a drop down menu:

- **Minimized Demo** - reduces the window to a button on the student taskbar. Students have access to the demonstration screen, but are not required to view it; they have access to their keyboards and mouse devices.

- **Demo in Window** - makes your screen a window on the student computers. Students have access to your screen, but are not required to view it; they have access to their keyboards and mouse devices.

- **Full-screen Demo** - maximizes the window so it covers the entire student screen. Student keyboards and mouse devices are locked.

3. (optional) To allow the student access to the his or her keyboard and mouse while you have remote control, click the Disable remote user input button.

4. To turn off the demonstration, click the Stop mode button.

### Move Files by Dragging

In Remote Control, you can drag files and file folders between your screen and a student screen in the Remote Control window. To enable or disable this feature, go to the Remote Control pane in the Tools -> Vision Preferences menu.

1. Take remote control of a student computer.

2. Find the file you want to move. You can move files between your computer and the student computer.

3. Drag the file from one desktop to the other.

**NOTE:** Large files may take more time to transfer.

### Copy and Paste Remotely

When you have control of a student computer, you can copy text and images from the student’s Clipboard and paste them to your own. Likewise, you can copy the contents from your Clipboard and paste it to the student's Clipboard.

**To Copy from a Student’s Clipboard**

1. Take remote control of a student computer.

2. On the Remote Control window, click the Copy from User Clipboard button.

   The content that is currently on the student’s Clipboard is pasted to your Clipboard. You can later paste this content to a document on your computer.
To Paste to a Student’s Clipboard

1. Take remote control of a student computer.

2. On the Remote Control window, click the Paste on User Clipboard button.

The content that is currently on your Clipboard is pasted to the student’s Clipboard. The student can then paste this content to a document on his or her computer.

Turn on Student Computers Remotely

You can turn on (or ‘wake up’) student computers remotely if those computers support Wake on Local Area Network. Contact your system administrator for information about the Wake-on-LAN (WOL) compliance of your student computers.

1. Connect to your classroom. You must be connected to a classroom before you can wake up student computers.

2. On the Special Commands pane, click Wake up Computer.

Start a Program on a Student Computer

Vision offers two ways to start programs on Student Computers.

Using App-Control: App-Control is a plug-in feature set of Vision that is installed by default in 30-Day Trial mode. It offers an easy-to-use drop down menu to select programs to run and allows you to lock or “kiosk” programs on student computers in order to prevent them from using other programs. For more information see the chapter More Vision Tools.

Using the Run Application feature: If you elect not to use App-Control, then Vision offers a simple command-line based method for starting programs on Student Computers.

Using the Run Application feature

From your computer you can start a program or open a Web site for your classroom or for individual students. This feature helps students follow along with the lesson and keeps them on task.

NOTE: In order to use this feature, programs must be located in the same directory on both the instructor and student computers.

NOTE: The Run Application button only appears in the Vision toolbar if App-Control is disabled or expired.

1. On the Vision toolbar, click the Run application button.

2. Start a program or open a Web site in one of the following ways:
• Drag a program shortcut from the Start menu, or a Web address from a browser address bar, to the Open box.

• Type the executable name of the program, such as Excel.exe for Microsoft Excel, or the address of the Web site.

• Click the down arrow to choose from a list of programs and Web sites you have used previously.

• Click Browse to search for a program.

3. (optional) If you want to start the program or open the Web site on your computer, select the Run selected application locally check box.

4. Click OK.

Shut Down Student Computers

From your computer you can log off students or shut down or restart student computers. This is useful at the end of the day or when your class no longer needs to use the computers.

1. On the Vision toolbar, click the Shutdown button.

2. Select one of the following options:
   • Shut down the computer
     Use this option to turn off the student computers.
   • Restart the computer
     Use this option to turn off the student computers and then automatically turn them back on. Windows often recommends that you restart a computer after you install new software or change computer settings.
   • Close all programs and log on as a different user
     Use this option to let other students quickly log on and use the computers. It is not necessary to shut down and restart computers when you want other students to log on to your classroom.
3. Select the check box **Force applications to exit** to close all programs that are running on the student computers.

**NOTE:** When you select this option students lose any unsaved data. For example, if a student has a Microsoft Word document open and you force all applications to quit, the computer shuts down without asking the student if she wants to save her changes.

4. Click **Yes**.
Live Supervision

Using the live supervision feature, you can closely observe a single student screen in real time (or near real time) without the student being aware of the action. When using this feature you cannot take control of the student’s mouse or keyboard.

Monitor a Student Computer in Real Time

From the instructor computer, you can open the **Live Supervision** window, which displays the student's screen.

**NOTE:** You do not have control over the student’s mouse or keyboard

Start Live Supervision of a Student Computer

Use one of the following methods to monitor a student computer:

- Double-click on a student computer.
- Right click on a student computer in the dashboard, and then select **Live Supervision**.
- Select a student computer in the dashboard, and then click the **Live Supervision** button.
- Click the arrow next to the **Live Supervision** button and select the student computer.
• The Live Supervision window opens

**TIP:** If you cannot see the student screen on your desktop, click the **Live Supervision** button in the taskbar.

**TIP:** You may open multiple Live Supervision windows for different students.

**Stop Live Supervision of a Student Computer**

• In the **Live Supervision** window, click the **Close** button in the upper-right corner of the window.

**Using Vision features from Live Supervision**

The Live Supervision window contains a toolbar that displays the most common and useful Vision features:

• Blank Screen
- Remote Control
- Virtual Teacher
- Stop (release student computer)
- Snapshot (if Pointer is activated)
Open Enrollment

Open Enrollment allows instructors to broadcast an invitation to a class over the network. Students can join or leave the classroom at any time without disturbing other students or the instructor. This feature works well in colleges and professional development classes where the attendees are fully capable of deciding to participate in the class.

Classrooms and student computers must be configured to allow Open Enrollment in order to use this feature. You can designate a classroom for Open Enrollment as you create it or you can change an existing classroom. You configure student computers for Open Enrollment when you install Vision.

**Open Enrollment Process**

1. Create a classroom and select the Open Enrollment option. For information on how to create an Open Enrollment classroom, see *Create a Classroom* on page 19.

**NOTE:** To determine if a class is configured for Open Enrollment, right-click a classroom icon, click **Properties**, and then click the **Connectivity** tab. The class is configured for Open Enrollment if the **Open Enrollment** check box is selected.

2. Connect to the classroom.

When you connect an Open Enrollment classroom, Vision sends an invitation to the students on your network whose computers are configured to use Open Enrollment.

3. Students see the invitation appear in the system tray (the notification area at the far right of the taskbar). From there, they click on the invitation to open the **Advertised Open Enrollment Classrooms** window that lists your class and computer name. Students double-click the class name to join it.

4. After students join the class, you can see their screen in the dashboard and use all Vision features that are available in a regular classroom.
Start an Open Enrollment Class

1. Open the Vision dashboard by double clicking the Vision icon on your desktop.

   NOTE: To determine if a class is configured for Open Enrollment, click the My Classrooms button in the toolbar and choose Manage Classrooms. Select the classroom you wish to use, click the Edit Classroom button, and then click the Connectivity tab. The class is configured for Open Enrollment if the Open Enrollment check box is selected.

2. On the Classroom toolbar, click the Connect Classroom button.

   When you connect to an Open Enrollment classroom, Vision sends an invitation to the students on your network whose computers are configured to use Open Enrollment. If students agree to attend your class, their computers appear in the dashboard and you can begin to use Vision features as you would in standard classroom.

3. To disconnect from a classroom and stop monitoring your students, click the Disconnect Classroom button.

Change an Existing Classroom to Allow Open Enrollment

1. Double-click the Vision icon on your desktop to open the Vision window.

2. Click the My Classrooms button in the toolbar and choose Manage Classrooms. Select the classroom you wish to use, click the Edit Classroom button, and then click the Connectivity tab.

3. On the Connectivity tab, select the Open Enrollment check box.

   NOTE: When you change an existing classroom to allow Open Enrollment, any student computers associated with the classroom are deleted.

Add or Change a Password to an Open Enrollment Classroom

You can require students to enter a password in order to access your open enrollment classes. This protects your classroom from unauthorized students attending your class.
1. Double-click the Vision icon on your desktop to open the Vision dashboard.

2. Click the My Classrooms button on the toolbar and select Manage Classrooms to open the Manage Vision Classrooms window and select the classroom you want.

3. Click Properties.

4. Click the Connectivity tab.

5. Check the Open Enrollment box.

6. Click the Change Password button.

7. Type your new password in the New password box, and type it again in the Confirm new password box.

Open Enrollment: What Students See

Student computers that are configured to use Open Enrollment can access classes through the Vision icon in the system tray (the notification area at the far right of the taskbar).
How Students Connect to an Open Enrollment Class

When you connect to an Open Enrollment classroom, Vision sends an invitation to the students on your network whose computers are configured to use Open Enrollment. Students see the invitation in the system tray.

Open Enrollment Class Invitation

To join the class, the student clicks on the invitation to open the Advertised Open Enrollment Classrooms window that lists your class and computer name.

The student selects your class name and clicks OK to join it. The connected student computer then appears in your dashboard. The student receives a message confirming the connection.
When you disconnect the Open Enrollment class, the student receives another message stating that his or her computer has been disconnected from the classroom.

How Students Connect to a Class in Session

Students who are late to class or miss the invitation when it appears can still connect to your class. To connect to an Open Enrollment class that is in session, the student right-clicks on the Vision icon in the system tray, points to **Open Enrollment**, and then clicks **Select advertised Classroom**.

The **Advertised Open Enrollment Classrooms** window opens. The student selects your class name and clicks **OK** to join it. The connected student computer then appears in the dashboard.

How Students Disconnect from an Open Enrollment Class

Students can disconnect from an Open Enrollment class while it is still in session. The student right-clicks on the Vision icon in the system tray, points to Open Enrollment, and then clicks **Disconnect Classroom**. When a student disconnects from your class, you no longer see that student computer in the dashboard.
Additional Vision Tools

Pointer, Surf-Lock and App-Control are licensed plug-ins that you can use with Vision to add feature sets. While these items are always included with Vision, they remain available in 30-Day Trial Mode only until they are licensed and activated. For information on how to purchase licenses for these features, visit our Web site at www.genevalogic.com.

**Pointer**

You use Pointer to annotate text or graphics on your screen during instruction. During class demonstrations, you can draw attention to areas of your screen using one of over 20 arrows, highlighters, and shapes. You can also zoom in and magnify any part of your screen or spotlight a particular object while the rest of the screen is dimmed.

You also use Pointer to capture screen images from student machines or from your own. These images can be used to record lessons or behavior that you wish to capture on screen.

**To make screen annotations**

1. On the Vision toolbar, click the **Pointer** button.

![Pointer toolbar]

2. From the **Pointer** toolbar, click the tool you want to use. For example, you can click the **Highlighter** button to change your mouse pointer to a highlight tool, which you use to draw on your screen. Or click the **Arrow** button to point out an area on your screen.
3. When you finish, click the **Erase** button, and then draw a frame around the object you want to remove.

**NOTE:** For more information on the available annotation tools, refer to Pointer Help.

**Capture images with Snap**

When **Pointer** is installed, the **Snap** icon will appear in the Vision toolbars:

Clicking this icon will place an image of the selected object in the **Snap Viewer** for sharing, saving and editing. You may capture images from your own screen, external sources or student images within **Remote Control** and **Live Supervision**

**Capturing a Screen Shot in Remote Control or Live Supervision**

1. Select a student computer

2. Begin a **Remote Control** or **Live Supervision** session

3. Click the **Snap** button in the toolbar to capture a picture of the student’s screen

4. The image appears in the **Snap Gallery** viewer.

**NOTE:** For more information on Snap and Snap Gallery, refer to Pointer Help.
Surf-Lock2

Surf-Lock2 controls student access to the Web. Internet access may be toggled on and off with a single click, or students may be restricted to teacher-designed lists of websites (Site Lists). Control can be applied to individual students or the entire class.

To lock and unlock access to the Web

1. On the Vision toolbar, click the Surf-Lock button.

Students cannot access the Internet.

2. To turn off Surf-Lock, click the Surf-Lock button again.
**Limit Web access to selected sites**

1. On the Vision toolbar, choose the **Surf-Lock** button and click the drop-down menu to display options.

<table>
<thead>
<tr>
<th>Lock Internet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply All Site Lists</td>
</tr>
<tr>
<td>Release All Site Lists</td>
</tr>
<tr>
<td>Site List Manager</td>
</tr>
</tbody>
</table>

   - Ancient Egypt
     - AP European History
     - Chapter 6 Quiz Links
     - Egypt Research Assignment
     - Geography Quest Project
     - Greeks and Romans
     - Just For Fun
     - Main Site Lists
     - School Web Sites
     - World Geography

2. Choose the Site List you wish to apply.

3. Student may now only access websites contained in the Site List.

4. To turn off Surf-Lock, choose **Release All Site Lists** from the Surf-Lock drop-down menu.
App-Control

App-Control allows you to launch applications on student computers in your Vision classroom in easy-to-use and innovative ways.

Launch an application on student computers

1. Click the App-Control button on the Vision Toolbar. A drop-down list of applications is shown.

2. Choose the desired application from the list in the “Standard” column

3. The application opens on all student computers, just as if it were launched locally.

Kiosk an application on student computers

Kiosking allows you to launch applications on student computers in a special “locked” mode that prevents access to all other functions of the computer.

1. Click the App-Control button on the Vision Toolbar. A drop-down list of applications is shown.

2. Choose the desired application from the list in the “Kiosk” column

3. The application opens on all student computers in Kiosk mode; access to other functions of the computer are disallowed
4. To end Kiosk mode, click the **Stop** button in the Vision toolbar

**NOTE:** Multiple applications can be run simultaneously in Kiosk mode, and students may access only these applications.

**Share a document with students**

1. Right-click a document you wish to share.

2. Choose **App-Control -> Share Document with Vision users**

3. In the dialog that opens, choose standard or Kiosk mode

4. The document opens on all student computers with the default application, just as if it were launched locally. Kiosking is applied if selected.

5. To end Kiosk mode, click the **Stop** button in the Vision toolbar
Vision Teach-Pad

The Vision Teach-Pad is a USB keypad that provides instant “one touch” access to key Vision functions in your classroom.

- Open My Classroom
- Start Demo
- Blank Screens
- Lock Internet (Surf-Lock)
- Release All (Stop)

Please contact your GenevaLogic reseller for pricing and availability.

http://www.genevalogic.com/